
2. Select a different card format if necessary.

3. Click Save. A download screen appears.

4. Select a location to download the file and click Save.

5. Open the file you just downloaded and print from your compatible document editor.

DownloadMembership Cards
Rather than print membership cards, you can download them as a .csv file after the print membership cards
process successfully completes. You can then send the .csv file to a printing service to print membership cards.

} Download membership cards

1. From the print membership cards process status page, click Download output. In the File Download
screen, choose to save the file. The Save As screen appears.

2. Browse to the location on the workstation or network to save themembership cards .csv file.

3. In the File name field, enter the name of themembership cards .csv file to create.

4. Click Save. The program generates themembership cards in a .csv file at the specified location. You can
then send the file to a third party to print membership cards.

Amessage appears that confirms the location where the .csv file was saved, and asks whether to display
the file.

• To view themembership cards .csv file, click Yes. Themembership cards file appears.

• To not view themembership cards .csv file, click No. You return to the print membership cards
process status page.

Membership Card Formats
Provided in the system are preconfigured membership card formats you can use when you print membership
cards. Each card format is a mail merge document created in MicrosoftWord. The card formats use data fields
that pull specific member and membership information from your database to create themembership cards and
content. For more information about the fields that can be added to a card format, see Membership Card
Format Data Fields on page 78.
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Note: You must haveMicrosoftWord installed to create your own membership card formats. Previous
experience creating mail merge documents in Word will be helpful when creating newmembership card
formats.

} Generate a membership card format header file

1. From theMarketing and Communications, under Configuration, click Letter template library. The
Letter Template Library page appears.

2. Under Tasks, click Generate header file. The Generate header file screen appears.

3. In the Letter type field, select “Membership card.”

4. In theOutput format field, select “Membership card output.”

5. In theHeader file field, click the ellipsis. The Save As screen appears. Browse to the location to save the
new *.csv header file and name the file.

Note: Make sure you save this file in an accessible location. It will be used as the data source when you create
themembership card format document inWord.

6. Click Ok. Amessage appears to determine if you want to open or save the *.csv file. Click Save. Now that
you have a membership card format header file to use as your data source, you are ready to create a
membership card format.

} Create a membership card format

You must haveMicrosoftWord installed to create your own membership card templates. This procedure guides
you through the steps required to create a contact document usingWord 2007.

1. FromWord, create a new blank document and write the body of themembership card format. The body
of the letter should provide context for the data fields you will add to the letter during this process. For
examples of how to format the letter, you can review the preconfigured templates included in the
system. For more information, see Membership Card Formats on page 72.

2. On the ribbon, select theMailings tab.

3. In the Start Mail Merge group, click Select Recipients, Use Existing List. The Select Data Source screen
appears.
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4. Browse to membership card format header file (*.csv) you previously created, select it and click Open.
The Header Record Delimiters screen appears.

5. Leave the default settings as they appear on the Header Record Delimiters screen and click OK. You
return to theWord document.

6. In theWrite & Insert Fields group, click Insert Merge Field. A list of themembership card data fields you
can add to themembership card format appears.
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Note: Prior to inserting a field, you can place your cursor in the document in the location where the field should
go within the body of themembership card format letter. You can also move the fields around as needed within
the document after they are inserted.

7. Select the appropriate data field to add and click Insert. The field is added to theWord document. Repeat
this step for each field you want to include in themembership card format.

Note: The data fields you place in themembership card format will be used to pull specific data from your
database when a membership card is created for a constituent. For a list of the fields you can insert and their
definitions, see Membership Card Format Data Fields on page 78.

8. To return to the document, click Close. When you are done inserting data fields and writing the body of
themembership card format, save and close the document. Now that you have a created the
membership card format, you are ready to add it to the Letter Template Library.

Note: Make sure you save the document in a format that is compatible with the version ofWord installed on
each workstation. For maximum compatibility, we recommend you save each template as a “Word 97-2003
Document (*.doc)” file. Also make sure you save the file in an accessible location.

} Add the membership card format to the Letter Template Library

1. FromMarketing and Communications, under Configuration, click Letter template library. The Letter
Template Library page appears.
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2. On the action bar, click Add. The Add letter template screen appears.

3. Enter a name and description for themembership card format.

4. In the Letter type field, select “Membership card.”

5. In theOutput format field, select “Membership card output.”

6. Next to Letter, click Choose file. The Open screen appears. Browse to themembership card format you
previously created, select the file, and click Open. You return to the Add letter template screen and a link
to the document is displayed.

Note: To view and edit the document, click the document link. If you have a compatible version ofMicrosoft
Word installed, themembership card format opens and you can view and edit it as needed.

7. Click Save. You return to the Letter Template Library page and the document is listed in theMembership
card section. Themembership card format is now saved in your database and can be selected when
creating personalized card formats for constituents.

Membership Card Format Data Fields
When you specify data fields in a membership card format, you can include information like themember’s name
and address, and membership program and level. You can also include themerge fields necessary to create the
membership card.
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Note: To include the barcode on themembership card, you must use the <<CARDNUMBER>> field, and use the
“3 of 9” font to display the field as a barcode. The wholemerge field must be set to the “3 of 9” font.

The following table includes a list of the data fields you can include in your membership card format. For
examples that illustrate how these fields are typically used in a membership card letter, see Membership Card
Formats on page 72.

Field name Description

BUSINESSPROCESSOUTPUT...PKID This field is related to a system business process and should not
be added to themembership card format.

ISGIFT Gift ofmembership
MEMBER Member’s name

GIVENBY If this membership was a gift ofmembership, this field displays
which constituent gave the gift ofmembership.

JOINDATE Membership join date
LASTRENEWEDON Date themembership was last renewed
LEVEL Membership level
PROGRAM Membership program
STATUS Current membership status
TERM Membership term
TYPE Membership type
CURRENTLEVELPRICE Price of the current membership level
NEXTLEVELNAME Name of the next highest membership level
NEXTLEVELPRICE Price of the next highest membership level
MEMBERSHIPCARDID Membership card ID

CARDNUMBER
Membership card number. This field is used to display the
barcode on themembership card. The font for this field must be
set to “3 of 9”.

MEMBERSHIPID Membership ID
NAMEONCARD Name that appears on themembership card
MEMBERSINCE Date the constituent first became a member
ADDRESS Member address
CITY Member city
STATE Member state
Zip code Member Zip code
PRIMARYADDRESSEE Primary addressee
PRIMARYSALUTATION Primary salutation
LASTORGGROUPNAME Last name or group name
CARDNUMBERDISPLAY Membership card number
REVENUEAMOUNT Amount of revenue from membership purchase
REVENUERECEIPTAMOUNT Revenue receipt amount
REVENUEREFERENCE Revenue reference
REVENUEDATE Date revenue was taken in
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Membership Reports
Active Membership Report 81

Membership Conversion Report 82

Membership Renewal Report 82

Membership Count Report 83

Benefits List Report 84

Membership Dues Revenue Report 84

Membership Projected Revenue Report 84

Membership Dues Statistics Comparison Report 85

Membership Appeals Report 86

Membership Activity Report 86

Membership Actuals Report 87

Membership reports help you evaluatemembership activity for your organization. You can print or export
reports in several different formats, such as .xls or .pdf.

Active Membership Report
This report provides a graphical view of the activemembership count at your organization. It also provides a view
of activememberships by level. Themembership level data includes the specific number ofmemberships per
level and the overall percentage of activememberships for each level.
To run the report, from a membership program, click Active membership under Reports. The Active
Membership Report page appears.
You make a selection in the Breakdown data field to determine if themembership count is displayed in the graph
as daily, weekly, monthly, or yearly data points. After you select the data and breakdown options, click View
Report.

Tip: By default, the Breakdown data field is set to “Monthly.”

chapter 6



Membership Conversion Report
Run theMembership Conversion Report to determine how effectively your organization converts low level
memberships to high level memberships. This report counts the number ofmemberships that upgrade or
downgrade from one level to another, the number ofmemberships that remain the same, and the number of
memberships that were not renewed. It also counts newmembers and members who rejoin, as well as the
number ofmembers who did not rejoin because they became deceased. You can also select whether to report
on membership conversion between levels or tiers. If you do not want to display membership levels or tiers with
no data, you can select to hide those columns and rows.

Note: Amembership does not upgrade or downgrade due to a change in membership term. Therefore,
memberships with only a term change are not included in the report.

To run the report, from a membership program, clickMembership conversion under Reports.

Note: Report results includememberships that expire or cancel during the selected date range.

Membership Renewal Report
Run theMembership Renewal Report to display renewal details for a membership program. For a time frame
that you specify, the report lists the number ofmemberships to expire. It also calculates the number and
percentage of renewed, upgraded, downgraded, dropped, or lapsed memberships for the program.

Note: The Renewed category also includes any rejoins for the program and dates specified.

To run the report, from a membership program, clickMembership renewal under Reports.
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Membership Count Report
You can use this report to view the number of activememberships for a specific month, quarter, or year grouped
by membership type or level. With the date filters provided, you identify the period of time that contains the
months, quarters, or years to run the report for. The report also provides several quick date options you can use
to view themembership count for the past threemonths, past six months, or past year.

Note: This report provides the number of activememberships, not members. For example, if a family
membership exists with four members, that counts as onemembership in this report. Additionally, the report
provides the number of activememberships that exist at the end of the selected month, quarter, or year.

To run the report, from a membership program, clickMembership count under Reports.
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Benefits List Report
Run the Benefits List Report to create a list of constituents who have benefits from memberships, revenue,
recognition programs, or events. The report lists the benefit item, along with the quantity and cost amount of
the benefit.

Warning: If you edit the value of a benefit in the benefits catalog, the new value does not appear on instances
of the benefit already associated with an appeal, event, membership, or revenue transaction and will not be
reflected in the report. To associate the new benefit value with pre-existing transactions, events, memberships,
or appeals, you must update those records. For more information about the benefits catalog, refer to the
Fundraising Guide.

To run the report, from a membership program, click Benefits list under Reports.

Membership Dues Revenue Report
TheMembership Dues Revenue Report displays revenue transaction details for a membership program in a time
frame that you specify. TheMemberships column displays the number of activememberships for the specified
level, and the Additional Gifts column displays the amount of revenue from all gifts given by any member of the
specified level.

To run the report, from a membership program, clickMembership dues revenue under Reports. The report
appears.

Membership Projected Revenue Report
TheMembership Projected Revenue Report displays projected revenue for a membership program. The
projections are based on expected revenue from membership renewals that include upgrades, downgrades, and
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rejoins.
The report contains a total row that calculates the sum of the projected revenue for levels in each program. It
also contains a total row that calculates the sum of the projected revenue for all levels and programs in a year.
The report calculations are broken out by each month in the calendar year.
To run the report, from a membership program, clickMembership projected revenue under Reports.

Membership Dues Statistics Comparison
Report
TheMembership Dues Statistics Comparison Report compares membership data for different time periods. You
select the time periods to compare and themembership program to use for the report. The report compares
membership dues amount and count information for the tiers and levels in the program. You can group the
report by channel or by activity. Channel displays how revenue was received such as by mail or phone. Activity
displays the type of transaction, such as a join or a renew.

Note: You select the channel in the Inbound channel field on the Add a payment screen. This field is a code
table so your organization can enter the options for the field.

For reports grouped by activity, only themost recent membership transaction within the selected periods is
counted in the Totals row. For example, if a member joins and renews within a selected period only, a single
membership is counted in the total. However, a join and a renew is added to each activity sub-total for the
period.
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Note: The retention rate is the percentage of existing memberships that opted to renew a membership during
the renewal opportunity. Lifetimememberships and memberships that are not due for renewal are excluded
from the calculation.

Reports grouped by channel behave similarly to reports grouped by activity. Only themost recent membership
transaction within a selected period is counted in the total. However, cancellations are not included in any
channel revenue sub-totals, since revenue is not generated by canceled memberships.
To run the report, from a membership program, clickMembership dues statistics comparison under Reports.

Membership Appeals Report
TheMembership Appeals Report compares performance information about a group ofmembership appeals
such as goals, amount raised, number of donors, number of gifts.
To run the report, from a membership program, clickMembership appeals under Reports.

Membership Activity Report
Before you run this report, a system administrator must install and configure a standard data mart. The data
mart places records from your source database in a data warehouse so you can conduct complex reporting and
analysis. For information about data marts, see theData Warehouse Guide.
To run the report, from a membership program, clickMembership activity under Reports. Select your
Membership program under the Filters tab, and specify the proper dates. Click View Report and you will see
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information on amounts ofmembers, renewals, upgrades, drops, and other membership activities. You can click
on specific numbers in the report to view a breakdown of those figures.
Activememberships will includememberships that were valid at any point during the specified date range.
Retention rate is calculated as the number ofmemberships at the end of the date range subtracted by the
number ofmemberships that joined during the date range, subtracted by the number ofmemberships that
rejoined during the date range, and then divided by the amount ofmemberships at the start of the date range.
Use the Layout tab to dividemembership activity statistics into groups, including country, ethnicity, month, and
level. Click View Report to view the statistical breakdown.

Note: Address fields (Country, State, County, City) are pulled from the primary address of primary member.
Education fields (Class Of, Degree) are pulled from the primary education of the primary member.

Note: You can export the report using the floppy disk icon into multiple formats, including XML, PDF, Excel, and
Word.

Membership Actuals Report
This report compares contributed revenue and earned revenue in two selected time periods. You can also view
the variance, or how spread out the distribution is, of contributed and earned revenue from this report.
Contributed revenue includes any revenue that is associated with a contributions-based membership. Earned
revenue includes any revenue that is associated with a dues-based membership.
Before you run this report, a system administrator must install and configure a standard data mart. The data
mart places records from your source database in a data warehouse so you can conduct complex reporting and
analysis. For information about data marts, see theData Warehouse Guide.
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To run the report, from a membership program, clickMembership actuals under Reports. Select your
Membership program under the Filters tab, and specify the proper dates in the Period fields. Click View Report
and you will see a comparison of Contributed and Earned Revenue in the two time periods. You can click on
specific numbers in the report to view a breakdown of those figures.
Use the Layout tab to dividemembership activity statistics into groups, including country, ethnicity, month, and
level. Click View Report to view the statistical breakdown.
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